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Abstract

KMouth is an application that enables persons that cannot speak to let their
computers speak.
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Chapter 1

Introduction

KMouth is a program that enables persons that cannot speak to let their com-
puters speak. It includes a history of spoken sentences from which the user can
select sentences to be re-spoken.

Note that KMouth does not include speech synthesizer. Instead it requires a
speech synthesizer installed in the system.

Please report any problems and feature requests to the author of KMouth.
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Chapter 2

Using KMouth

2.1 The first start

During the first start of KMouth, a wizard is displayed into which you can
enter some basic configuration.
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With the first page of the wizard (the left screen shot) you specify the command
that shall later be used for the text-to-speech conversion. For more details look
into the description of the configuration dialog.

With the second page you select which standard phrase books you need. From
the phrase books you later can select often used phrases so that you do not
need to type them in. Of course KMouth also has an edit dialog for the case
that you later want to edit your phrase books.

With the third page (the right screen shot) you define the dictionary for a word
completion. KMouth will parse the KDE documentation of the chosen lan-
guage in order to detect the frequentness of individual words. Optionally you
can compare the word list to an OpenOffice.org dictionary in order to only add
correctly spelled words to the word completion.
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2.2 The Main Window

The main window of KMouth is fairly simple. It consists basically of an edit
field into which you type your sentences (the lower white field in the screen
shot) and a history of spoken sentences (the upper white field in the screen
shot).
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Assuming that you have correctly configured KMouth you can use the edit
field for entering sentences you want to hear. Once a sentence got spoken it
will be appended to the history. From the history you can select sentences to
be re-spoken.

From the phrase books (located in the line below the tool bar) you can select
often used phrases.

2.3 The Configuration Dialog

By using the menu entry Settings — Configure KMouth... you open the config-
uration dialog of KMouth. This dialog consists of the pages General Options
with the two tabs Text-to-Speech and Preferences, the page Word Completion
and the page KTTSD Speech Service
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2.3.1 The Text-to-Speech tab

General Options

|

General Options | Ereferences | Text-o-Speech

S Command for speaking texts:
Word Completion |."usnf|ocal.ffestival.fbin!festival —-tts] ng
Charader encoding:
| Local (|50 8859-1) > )
[®| Send the data as standard input
[®| Use kitsd speech service if possible
Help q (8] 4 P | Apply )| Cancel |

Into the edit field of the Text-to-Speech tab you enter the command for calling
the speech synthesizer. With the combo box below the edit field you specify the
character encoding that is used for passing the text to the speech synthesizer.

KMouth knows two ways of passing the text: If the command expects the text
as standard input you select the check box.

The other way is to pass the text as a parameter: Before calling the command
KMouth replaces certain placeholders with actual content:

Placeholder Replaced with
ot The actual text that should be
spoken
The name of a temporary file that
%f contains the text that should be
spoken
The language code associated with
%l the current word completion
dictionary
%% A percent sign

Off course the command for speaking texts is dependent on which speech syn-
thesizer you use. Please look into the documentation of your speech synthe-
sizer for the command for speaking texts. You can find examples for the com-
mand in the appendix.



The KMouth Handbook

By selecting Use KTTSD speech service if possible you tell KMouth first to try
to send the text to the KTTSD speech service. If this succeeds the other con-
figuration entries on this tab are ignored. The KTTSD speech service is a KDE
daemon which gives KDE applications a standardized interface for speech syn-
thesis and is currently developed in SVN. It is safe to select this option even if
KTTSD is not installed.

2.3.2 The Preferences tab

General Options

|

General Options | | Preferences | Text-to-Speech

= L. Selection of phrases in the phrase book:
Word Completion
Insert Into Edit Field ¥
( J
Closing the phrase book edit window:
l Ask Whether to Save ¥ J
Help q 0K h Apply )| Cancel J

The Preferences tab contains options that alter the behavior of KMouth in cer-
tain situations.

With the first combo box, Selection of phrases in the phrase book:, you specify
which action is triggered by typing the shortcut of a phrase or by selecting a
phrase in the Phrase Book menu or in the phrase book bar.

By selecting Speak Immediately the selected phrase gets immediately spoken
and is entered into the history. If you select Insert Into Edit Field the selected
phrase is just inserted into the edit field.

With the second combo box, Closing the phrase book edit window:, you spec-
ify whether the phrase book gets saved if you just close the phrase book edit
window.

By selecting Save Phrase Book the phrase book gets saved. If you select Discard
changes the changes are discarded and the phrase book is not saved. If you
select Ask Whether to Save KMouth will ask you whether it shall save the
phrase book.
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2.3.3 The Word Completion page

o O E
o3 Word Completion
\q\‘j
General Options Dictionary | Language ] [ TR — J
— Default English Us {en_US)
=9 &) | Delete Dictionary |
Word Completion
| Move Up |
— Selected Dictionary
| Mowe Down J
Name: |Defau|t|
Language:l English US (en_US) 1 | Export Dictionary... J
Help (8] 4 | Apply )| Cancel |

The Word Completion page contains a list of dictionaries used for the word
completion. (KMouth will display a combo box next to the edit field in the
main window if this list contains more than one dictionary. You can use this
combo box in order to select the dictionary that actually gets used for the word
completion.)

With the buttons on the right side of the page you can add and delete dictio-
naries, change the order of the dictionaries or export dictionaries to a file. With
the edit field and the combo box below the list you can change the name and
the language associated with the dictionary.

When you add a new dictionary you may choose between several sources:

e Create a new dictionary from the KDE documentation

If you use this source KMouth will ask you for the intended language and af-
terwards parse the KDE documentation. The frequentness of the individual
words is detect by simply counting the occurrences of each word. Optionally
you can compare the word list to an OpenOffice.org dictionary in order to
only add correctly spelled words to the new dictionary.

e Create a new dictionary from a file

If you use this source KMouth will ask you for the intended file. You may ei-
ther select an XML file, a standard text file or a file containing a word comple-
tion dictionary created by either KMouth or GOK (the GNOME On-screen
Keyboard). If you select a standard text file or an XML file the frequentness
of the individual words is detected by simply counting the occurrences of
each word. Optionally you can compare the word list to an OpenOffice.org
dictionary in order to only add correctly spelled words to the new dictionary.
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e Create a new dictionary from a folder

If you use this source KMouth will ask you for the intended folder. KMouth
will open all files in that folder and its subdirectories. Each file is either
loaded as a completion dictionary, as an XML file or as a standard text file.

In the latter two cases the occurrences of each individual word in the file
is counted. Optionally you can compare the word list to an OpenOffice.org

dictionary in order to only add correctly spelled words to the new dictionary.
e Merge dictionaries
You can use this option in order to merge the available dictionaries. KMouth
will ask you which dictionaries should be merged and how the individual
dictionaries should be weighted.
e Create an empty word list

You can use this option in order to create a blank dictionary without any en-
tries. As KMouth automatically adds newly typed words to the dictionaries
it will learn your vocabulary with the time.

2.3.4 The KTTSD Speech Service page

The configuration of the KDE Speech Service is described in detail in the KTTS
Handbook.

2.4 The Phrase Book Edit Window

By using the menu entry Phrase Books — Edit... you open the phrase book edit
window.


help:kttsd
help:kttsd

The KMouth Handbook

Eile Edit Help

EAEEES & & x
Phrase | Shortcut | #
--[F)Courenusness
E
¥

- [ thanks

- [ thank you

- [ thank you very much
- [ please

- [ here you are

- [ vou are welcome

=1

— Currently Selected Phrase ar Phrase Book
Taxt of the phrase:

[thanks|
Shorcut for the phrase:

(=) Mone () Custom H Mone I

The main area of the phrase book edit window is divided into two parts. Within
the upper part the phrase books are displayed in some tree structure.

Within the lower part you may modify a selected item. If you have selected a
phrase you can modify the contents of the phrase as well as its shortcut. If you
have selected a phrase book you can only change its name.

Actions like adding new phrases and phrase books and deleting selected phrases
and phrase books can be done by selecting them in either the menu bar, the
toolbar or a pop up menu.

You can change the order of the phrase books and phrases by dragging them
to their new places or by using the arrow keys while the Alt key is pressed.
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Chapter 3

Command Reference

3.1 Commands Within The Main Window

3.1.1 The File Menu

File — Open as History... (Ctrl-O) Opens a text file into as history of spoken
sentences.

File — Save History As... (Ctrl-S) Saves the history into a text file.
File — Print History... (Ctrl-P) Prints the history.
File — Quit (Ctrl-Q) Quits KMouth

3.1.2 The Edit Menu

Edit — Cut (Ctrl-X) Cuts the selected section and puts it to the clipboard. If
there is some text selected in the edit field it is placed it on the clipboard.
Otherwise the selected sentences in the history (if any) are placed on the
clipboard.

Edit — Copy (Ctrl-C) Copies the selected section to the clipboard. If there is
some text selected in the edit field it is copied to the clipboard. Otherwise
the selected sentences in the history (if any) are copied to the clipboard.

Edit — Paste (Ctrl-V) Pastes the clipboard contents at the current cursor posi-
tion into the edit field.

Edit — Speak Speaks the currently active sentence(s). If there is some text in
the edit field it is spoken. Otherwise the selected sentences in the history
(if any) are spoken.
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3.1.3 The Phrase Books Menu

Phrase Books — Edit... Opens the phrase book edit window.

3.1.4 The Settings Menu

Settings — Show Menubar (Ctrl-M) When checked, this displays the menubar.
When unchecked the menubar is hidden.

Settings — Show Toolbar When checked, this displays a movable toolbar con-
taining buttons used to initiate frequently used commands. The toolbar
is most commonly located at the top of the editor just under the menu.
When unchecked the toolbar is hidden. Clicking on the striated grip and
dragging allows the user to move the bar.

Settings — Show Statusbar When checked, this displays a small bar at the
bottom of the main window containing information about the status of
KMouth. When unchecked the status bar is hidden.

Settings — Show Phrasebook Bar When checked, this displays a movable phrase-
book bar containing buttons for the phrasebook entries. The phrasebook
bar is most commonly located at the top of the editor just under the tool-
bar. When unchecked the phrasebook bar is hidden. Clicking on the
striated grip and dragging allows the user to move the bar.

Settings — Configure KMouth... Opens the configuration dialog for the speech
synthesizer and other KMouth settings.

3.1.5 The Help Menu

Help — KMouth Handbook (F1) Invokes the KDE Help system starting at
the KMouth help pages. (this document).

Help — What's This? (Shift+F1) Changes the mouse cursor to a combination
arrow and question mark. Clicking on items within KMouth will open a
help window (if one exists for the particular item) explaining the item’s
function.

Help — Report Bug... Opens the Bug report dialog where you can report a
bug or request a ‘wishlist’ feature.

Help — Switch Application Language... Opens a dialog where you can edit
the Primary language and Fallback language for this application.

Help — About KMouth This will display version and author information.

Help — About KDE This displays the KDE version and other basic informa-
tion.

10
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3.1.6 The pop up menu of history entries

Speak The selected sentences are spoken.

Delete The selected sentences are removed from the history.

Cut The selected sentences are deleted and placed on the clipboard.
Copy The selected sentences are copied to the clipboard.

Select All Entries All history entries are selected.

Deselect All Entries All history entries are deselected.

Open as History... (Ctrl-O) Opens a text file into as history of spoken sen-
tences.

Save History As... (Ctrl-S) Saves the history into a text file.

3.2 Commands within the phrase book edit window

3.2.1 The File Menu

File — New Phrase Adds a new phrase.

File — New Phrase Book Adds a new phrase book.

File — Save (Ctrl-S) Saves the phrase book.

File — Import... Imports a file and adds its contents to the phrase book

File — Import Standard Phrase Book Imports a standard phrase book and adds
its contents to the phrase book

File — Export... Exports the currently selected phrase(s) or phrase book(s) to a
file

File — Print... (Ctrl-P) Prints the currently selected phrase(s) or phrase book(s)
File — Close (Ctrl-W) Closes the window

3.2.2 The Edit Menu

Edit — Cut (Ctrl-X) Cuts the selected items and puts it to the clipboard.
Edit — Copy (Ctrl-C) Copies the selected items to the clipboard.
Edit — Paste (Ctrl-V) Pastes the clipboard contents into the phrase book.

Edit — Delete Deletes the selected items.

11
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3.2.3 The Help Menu

Help — KMouth Handbook (F1) Invokes the KDE Help system starting at
the KMouth help pages. (this document).

Help — What's This? (Shift+F1) Changes the mouse cursor to a combination
arrow and question mark. Clicking on items within KMouth will open a
help window (if one exists for the particular item) explaining the item’s
function.

Help — Report Bug... Opens the Bug report dialog where you can report a
bug or request a ‘wishlist’ feature.

Help — Switch Application Language... Opens a dialog where you can edit
the Primary language and Fallback language for this application.

Help — About KMouth This will display version and author information.

Help — About KDE This displays the KDE version and other basic informa-
tion.

3.2.4 The Pop up Menu

New Phrase Adds a new phrase.
New Phrase Book Adds a new phrase book.
Import... Imports a file and adds its contents to the phrase book

Import Standard Phrase Book Imports a standard phrase book and adds its
contents to the phrase book

Export... Exports the currently selected phrase(s) or phrase book(s) to a file
Cut (Ctrl-X) Cuts the selected items and puts it to the clipboard.
Copy (Ctrl-C) Copies the selected items to the clipboard.

Paste (Ctrl-V) Pastes the clipboard contents at this position into the phrase
book.

Delete Deletes the selected items.

12
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Chapter 4

Questions and Answers

This document may have been updated since your installation. You can find
the latest version at http://docs.kde.org/ .

1. I do not hear anything.

Most likely you did not configure correctly (or not at all?) the text-to-
speech command. Use Settings — Configure KMouth..., open the page
General Options and enter the command for speaking texts on the tab
Text-to-Speech. (See section about the configuration dialog for the speech
synthesizer for more details.)

13
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Chapter 5
Credits and License

KMouth
Program copyright 2002-2004 Gunnar Schmi Dtgunnar@schmi-dt.de

Documentation copyright 2002-2004 Gunnar Schmi Dt gunnar@schmi-dt.de

This documentation is licensed under the terms of the GNU Free Documenta-
tion License.

This program is licensed under the terms of the GNU General Public License.

14
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Appendix A

Examples for the
text-to-speech configuration

1. Festival

Festival is a text-to-speech system written from the University of Edin-
burgh. It currently supports English, Spanish and Welsh speech. Its li-
cense allows to use and distribute Festival free of charge without restric-
tions. In order to create the command line example for the text-to-speech
configuration we assume that Festival is installed in the directory /usr/-
local/festival/. The command for speaking texts then is as follows:

/usr/local/festival/bin/festival --tts

The option Send the data as standard input must be enabled.

. FreeTTS

FreeTTS is a speech synthesizer written entirely in the Java'™&#8482;
programming language. It currently only has support for English pro-
nounciation. Its license allows to use and distribute FreeTTS free of charge
without restrictions. In order to create the command line example for the
text-to-speech configuration we assume that FreeTTS is installed in the
directory /usr/local/freetts/. The command for speaking texts then
one of the following three examples:

java -jar /usr/local/freetts/lib/freetts.jar -text %t

java -jar /usr/local/freetts/lib/freetts.jar -file &%f

java -jar /usr/local/freetts/lib/freetts. jar

For the third example the option Send the data as standard input must
be enabled. (This one is the preferred example for the use with FreeTTS.)

15
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3. MBROLA
MBROLA is a speech synthesizer for a large number of languages. It
converts a list of phonemes to a wave file, so you need some other tool to
convert the text into a list of phonemes. The license of MBROLA allows to
use and MBROLA free of charge for non-commercial, non-military appli-
cations. For our example we will use Hadifax in order to convert German
texts into a list of phonemes suitable for MBROLA. We will assume that

Hadifax and MBROLA are installed to /usr/local/hadifax/ and /usr/-
local/mbrola/. Unfortunately Hadifax tends to swallow the last charac-

ter of the text, so we may want to add an additional character to the text.
The complete command is therefore more complex than the previous ex-
amples:

(cat -; echo " ") | /usr/local/hadifax/txt2pho -f
| /usr/local/mbrola/mbrola -e
/usr/local/mbrola/del/del - /tmp/tmp.wav;
artsplay /tmp/tmp.wav; rm /tmp/tmp.wav

All parts of this command need to be written into one line. The option
Send the data as standard input must be enabled.

4. The KDE Text-to-Speech Daemon

The KDE Text-to-Speech Daemon (KTTSD) is a KDE wide text-to-speech
service which gives KDE applications a standardized interface for speech
synthesis and is currently developed in SVN. It uses plug-ins in order
to support various text-to-speech systems. As the configuration of the
speech synthesizer is done in KTTSD the only KMouth-specific option
you need to activate is Use KTTSD speech service if possible. Of course
you need to configure KTTSD. You may do this with the configuration
page KTTSD Speech Service that is added to the configuration dialog of
KMouth if KTTSD is installed.

16



The KMouth Handbook

Appendix B

Installation

B.1 How to obtain KMouth

KMouth is part of the KDE project http:/ /www.kde.org/ .

KMouth can be found in the kdeaccessibility package on ftp://ftp.kde.org/-
pub/kde/ , the main FIP site of the KDE project.

B.2 Requirements

In order to successfully use KMouth, you need a speech synthesizer (and of
course KDE 3.x). KMouth uses about 15 MB of memory to run (plus the amount
of memory needed by your speech synthesizer), but this may vary depending
on your platform and configuration.

B.3 Compilation and Installation

For detailed information on how to compile and install KDE applications see
Building KDE4 From Source

Since KDE uses cmake you should have no trouble compiling it. Should you
run into problems please report them to the KDE mailing lists.

17
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